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1.0  Introduction 
 
The US Drives Drivemaster software is designed to 
control, setup, and monitor the PHOENIX DX & EX line 
of digital AC drives from US Drives, Inc. Drivemaster 
software has an interface that allows the user to 
control the drive “online” (when connected to the 
drive via a serial interface) or to perform various 
management functions offline and save the changes to 
be downloaded to the drive at a later date. The 
PHOENIX DX & EX serial protocol is based upon the 
Modbus RTU protocol and features full CRC protection 
in both directions. The following sections of this 
manual describe the installation and setup of 
Drivemaster software, as well as the operation of 
Drivemaster’s various windows and dialog boxes. 
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2.0  Initial Setup 
 
First, run the setup.exe provided for Drivemaster, and 
follow the instructions to install Drivemaster. Upon 
running Drivemaster for the first time, you will 
probably need to adjust the Serial Port configuration 
to match the settings on your drive (i.e. adjusting the 
baud rate for higher-speed communication, etc). See 
“Configuring the Serial Port” for instructions on how to 
do this. 

 
Next, you can connect to a drive to test your serial 
port configuration and to upload the drives data for 
use with offline editing or downloading to another 
drive. Connect the serial port you configured to the 
drive and select “Upload to PC” from the File menu. 
Input the correct Drive Address into the appropriate 
box and click “Start Upload”. The upload will take 
around four minutes at the default 9600-baud 
connection speed, or about 30-90 seconds at 19.2 
kbd.  
 
Or, you can use the existing files provided to edit 
offline and download to drive later. 

 
Drivemaster is now set up and ready to run. The 
remainder of this document provides detailed 
descriptions of the operation of each window and 
dialog. 
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3.0  Main Window 
 
The main window contains all other windows of the 
Drivemaster program, as well as the main menu, 
which is used to select among the various functionality 
available in the software. 
  

 
Figure 1.  The Main Window. 

 
File Menu – Contains operations for dealing with data 
files transferred to and from the drive. 

• Upload To PC – Upload all data from a drive to 
a file for offline editing. Requires a connection 
to the drive. See the “Upload/Download 
Dialog” section for details. 

• Download To Drive – Download all data from 
a drive information file to the drive, overriding 
its parameters with the ones in the file. 
Requires a connection to a drive. See the 
“Upload/Download Dialog” section for details. 

• Print Parameter List – Print drive information 
file either uploaded or edit offline. 

• Compare Files – Compare two drive 
information files, producing a report that lists 
the differences between them. See the “File 
Compare Window” section of this manual for 
details. 

• Exit – Closes Drivemaster. 
 
Communications Setup Menu – Contains 
operations for adjusting the way Drivemaster behaves. 

• Configure Serial Port – Allows the user to set 
the details of the serial port and adjust it to 
match the configuration of your drive. See 
“Configuring the Serial Port” for more 
information. 

• Configure Ethernet – Allows the user to set 
details at the IP address.  See “Configuring 
Ethernet Control” for more information. 

• Apply Firmware Upgrade - Allows the user to 
upgrade a drive to a specific software version. 

 

Edit Drive Parameters Menu – Contains operations 
for editing drive parameters. 

• Edit Parameter File (Offline) – Allows the user 
to edit a drive information file while not 
connected to a drive, so that changes to the 
drive’s settings can be designed elsewhere 
and then simply downloaded on-site. See “Edit 
Parameter File (Offline) Window” for more 
information. 

• Edit Parameters Online – Allows the user to 
get drive parameter value reports updated on 
the fly, save drive parameter values to a file, 
and change drive parameters directly. 
Requires a connection to a drive. See “Edit 
Parameters Online Window” for more 
information. 

• Customize Quick Setup Menu – Wizard which 
guides you thru setting up the Drive Quick 
Setup Menu.  See the “Customizing Quick 
Setup Menu Wizard” section of this manual for 
details. 

 
Scan/Graph/Log Menu – Contains operations to 
graph and log drive parameters. 

• Online Graph/Log – Allows the user to graph 
selected drive parameter value at a periodic 
rate.  Graphically display and log to a file 
selected drive parameters values at a periodic 
rate.  See “Online Graph/Log” window for 
more information. 

 
Window Menu – Contains operations to arrange 
Drivemaster windows. 

• Cascade – Rearranges Drivemaster open 
windows cascaded. 

• Tile Horizontally – Rearranges Drivemaster 
open windows horizontally. 

• Tile Vertically – Rearranges Drivemaster open 
windows vertically. 

 
Help Menu - Contains information about Drivemaster. 

• About Drive Master – Shows Drivemaster 
version information. 
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Note: If you are using a 
USB-to-serial adapter, you 
will have to set up a 
“virtual” COM port to 
represent one of the 
available COM ports. Consult 
your adapter’s manual or 
manufacturer for directions 
to set up a virtual COM port 
or determine which COM 
port your adapter is 
registered as. 

4.0  Configuring the Communications 
 
Before the Drivemaster software can communicate with a 
drive, the Drivemaster communication must be setup.  You 
can configure serial port and Ethernet setup individually. 
Using the serial port or Ethernet connection can be selected 
by opening either configuration.  A short cut to open either 
configuration “CTRL+S” for configuring Serial port or 
“CTRL+E” for configuring Ethernet can be used. 
 
4.1  Configuring the Serial Port 
 
Before the Drivemaster software can communicate with a 
drive, the serial port settings must be configured to match 
the settings on the drive. (The default settings are identical 
to the default settings of the drive, but depending on your 
application you may wish to adjust those settings. If so, you 
must also adjust the Drivemaster serial port configuration to 
match them.) 
 
The Serial Port Configuration dialog is accessed via the 
Communication Setup menu. It contains options for setting 
the port, baud rate, and 
parity of the serial 
interface. (The number of 
stop bits and data bits in 
the communications 
protocol depend on the 
other settings, so you 
cannot directly adjust 
them.) “Set to Defaults” 
will reset all these 
parameters to the factory 
defaults (which match the 
factory defaults of the 
drive.) 
 
When you click “Apply” or “OK”, Drivemaster will attempt to 
open the serial port using the settings you selected. If it 
cannot open the serial port (probably due to a 
misconfiguration or another application currently using the 
chosen serial port) it will announce an error, and all drive 
operations that require a connection will be disabled until 
you reconfigure the serial port. 
 

 
Figure 2.  The Serial Port Configuration Dialog. 

 

4.2  Configuring the Ethernet Control 
 
Before the Drivemaster software can communicate with a 
drive, the Ethernet control settings must be configured to 
match the Ethernet Communication board. 
 
The Ethernet Control Configuration dialog is accessed via 
Communication Setup menu.  It contains options for setting 
the IP address and port number.  Drivemaster 
communicates using Modbus USD protocol on Modbus TCP 
Ethernet frame.  The default port number for Modbus TCP is 
502.  The user can enter more than one IP address and 
same to a list.  By double clicking on an IP address in the list 
will load for use.  The Ethernet Communication board has a 
security feature that allows only communications with 
private key authentication.  This communication connection 
is established using a password that is matched with the 
Ethernet Communication board.  By selecting “Use Private 
Key Authentication” and entering the correct password, you 
will be connected to the Ethernet Communication board 
using DRIVEMASTER.   When you click “Apply” or “OK”, 
Drivemaster will now use the IP address and port number 
using the settings you selected. 
 

 
Figure 3.  The Ethernet Control Configuration Dialog. 
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5.0  Upload/Download Dialog 

 

 
Figure 4.  The Upload/Download Dialog. 

 
The Upload/Download dialog (accessed via the File 
menu) allows the user to upload all of the parameter 
data for a drive to the computer and storing it in a 
drive parameter data file (.USB file). The parameter 
data can then be edited by the Edit Parameter File 
(Offline) window or kept as a backup. Downloading 
the USB file later will overwrite existing parameters. 
This allows most of the management and setup work 
for the drive to be done offline, and the computer 
need only be connected to the drive long enough to 
download the finished file. 

 
To upload drive parameters, select “Upload to PC” 
from the main window’s File menu. This will open the 
dialog for uploading. Enter the drive address of the 
drive whose parameters you wish to upload into the 
“Drive Address” box. (The address the drive will listen 
on for serial communications is determined by 
M11P23, “Serial Address”. The address you attempt to 
upload from must be the same as this one or the drive 
will not respond.)  Next, click “Start Upload” to begin 
uploading the drive’s data. A progress bar will appear 
showing the status of the upload, and the two 
textboxes will show the uploads progress parameter-
by-parameter. When the textbox reads “Upload 
Complete”, the user can save the uploaded 
parameters by clicking “Save As” to get a standard 
windows file selection dialog.  A description for the file 
being saved can also be typed in before saving. You 
may now download it to a drive (see below) or open it 
in the offline editor window (see “Edit Parameter File 
(Offline)”). 

 
To download a file, select “Download to Drive” from 
the File menu. This will open the dialog for 
downloading. Click “Browse…” and find the file you 

wish to download, verify that the Drive Address is 
correct as before, and click “Start Download” to begin 
downloading the drive data. 
 
The download will write out the parameters from the 
drive parameter data file (.USB file) to the drive, 
display the description of the drive parameter data file 
(.USB file), and the textboxes and progress bar will 
show the current status of the download. When the 
entire file has been downloaded, the textbox will read 
“Download Complete.” If an error is returned by the 
drive during either upload or download, it will be 
reported to the user and the operation will 
immediately abort. 

 
Tip:  When your drive is finally properly configured, 
upload a snapshot of its parameters and keep it 
someplace safe as a backup.  If something then goes 
wrong, you can upload a new snapshot and use the 
Compare window to compare it to the “correct” 
settings, to determine whether the problem lies in a 
parameter that was erroneously changed.



EDIT PARAMETERS ONLINE WINDOW     6-1 
6.0  Edit Parameters Online Window 
 

 
Figure 5.  The Edit Parameters Online Window. 

 
The Edit Parameters Online window allows the user to 
keep track of the status of a drive in real-time, log the 
data received, and also change the parameters on the 
fly. The Edit Parameters Online window is accessed 
from the Edit Drive Parameters menu. At the top of 
the window, input the drive address you wish to query 
in the “Drive Address” box. This should match the 
drive’s “Serial Address” parameter (M11P23). Next, 
click the “Connect” button to connect to the drive. The 
progress bar will display the status of the connection, 
as Drivemaster connects to the drive and uploads the 
complete parameter list. The colored box in the upper 
left will flash to indicate communication with the drive. 

 
When the connection and upload is complete, the tree 
view on the window will be filled with the menus and 
parameters available on the drive. Clicking on the plus 
sign next to the menu will expand that menu’s 
parameters and clicking on the minus sign next to the 
menu will contract that menu’s parameters.  The 
expanding menu will display the parameters and 
parameter values. 

 
At a periodic interval, Drivemaster will poll the drive 
and read in the new values of the parameters. At 
anytime, you may click on a value and edit it live; your 
change will be sent to and verified from the drive 
immediately, and the new value will be displayed. 
Grayed-out parameters are read-only and cannot be 
edited. Parameters with names for their values will 
allow the user to select from among the named 
values. 
 
 

The user can save the drive parameters by clicking 
“Save to File” to get a standard windows file selection 
dialog.  A description for the file being saved can also 
be typed in before saving. 
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7.0  Edit Parameter File (Offline) 
Window       
         

 
Figure 6.  The Edit Parameter File (Offline) Window. 

 
The Edit Parameter File (Offline) window allows the 
user to edit the parameter values stored in a drive 
parameter data file (.USB file) and save them to a new 
file. This is especially useful after deployment, when a 
drive may not be in a readily accessible location—the 
drive’s parameters can be uploaded to a laptop by 
Drivemaster and then taken elsewhere to be analyzed 
and edited. The edited file with corrected parameters 
can subsequently be brought back and downloaded to 
the original drive to update it, making updating 
settings in the field much more convenient. 

 
Superficially, the Edit Parameter File (Offline) window 
(accessed from the Edit Drive Parameters menu) 
strongly resembles the Edit Drive Parameters Online 
window. The major difference is that no connection to 
a drive is required to use the Edit Parameter File 
(Offline) window.   Click “Browse…” and find the file 
you wish to edit.  Drivemaster will load the drive 
parameter data file (.USB file) into memory, display 
the description of the drive parameter data file (.USB 
file), and display the tree view much like that seen in 
Edit Parameters Online mode.  Clicking on the plus 
sign next to the menu will expand that menu’s 
parameters and clicking on the minus sign next to the 
menu will contract that menu’s parameters.  The 
expanding menu will display the parameters and 
parameter values. 
 
The parameters value can be clicked and edited 
exactly as with the Edit Parameters Online window. 
Parameters that are grayed out are read-only 

parameters and cannot be changed (such as, for 
example, the firmware version number of the drive). 
Clicking a parameter that has names for its values 
(such as the drive’s current Ramp Mode, for example) 
allows the user to select from all named values. A 
description for the file being edited can also be typed 
in.  When finished editing, click “Save As…” to save 
the file. You will be given a standard windows save-file 
dialog to choose a file name. The resulting file can 
then be downloaded to a drive as normal.
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8.0  File Compare Window 

 

 
Figure 7.  The Compare Files Window. 

 
The File Compare window allows the user to view the 
differences between two drive parameter data files 
(.USB file). This can be immeasurably useful for 
troubleshooting purposes; by uploading and keeping a 
safe copy of the “correct” parameter data for the 
drive, a problem due to an accidentally changed 
parameter or a typo in editing can be detected simply 
by uploading the “bad” drive data and comparing the 
resulting file to the “known-good” file. (For example, 
mistakenly entering a reference frequency of 600 
instead of 60.0 may cause problems, but this will be 
apparent upon examining the differences between the 
files.) 
 
To compare two files, open the File Compare window 
(select “Compare Files” from the File menu). Click the 
two “Browse” buttons and select a file to compare (by 
default, File 1 is the last file you uploaded, 
downloaded, or edited offline) and a file to compare it 
to (the second file is blank by default). Click “Compare 
Files” to begin comparing the files. 
 
The results are displayed in a spreadsheet format; the 
keypad number and name of the parameter are listed 
at the far left, the parameter values for File 1 are 
listed on the left, and the parameter values for File 2 
are on the right. Parameter values that are the same 
are not shown by default; un-checking “Show only 
differing parameters” will show parameters that are 
shared among the files as merged cells with the value 
in between the two columns. 
 
After the comparison is complete, the spreadsheet can 
be erased by clicking “Clear Result”, saved to a file by 
clicking “Save Result”, or a hard copy printed by 
clicking “Print Report”. The saved result file is a text 
file separated by tabs, which is human-readable and 
can be imported into any software package that 
supports tab-separated tables in ASCII format (e.g. 

Microsoft Excel) if automated processing or charting is 
desired. 
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9.0  Print Parameter List 

 

Figure 8. The Print Parameter List Window. 
 
The Print Parameter List window allows user to print a 
hard copy of any drive parameter data file (.USB file).  
This file can be an uploaded file, to be downloaded 
file, or edited offline file. 
 
To print a file, select “Print Parameter List” from the 
main window’s file menu.  This will open a standard 
windows file selection dialog.  Find the file you wish to 
print and click “Open”. 
 
A standard windows print dialog which allows you to 
print a hard copy to selected printer by clicking “Print”.
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10.0  Customizing Quick Setup Menu 
Wizard 

 
Figure 9. The Upload Parameter Data Window. 

 
The Customize Quick Setup Menu wizard allows the 
user to select parameters for Quick Setup Menu.  The 
wizard also allows you to adjust the scale and 
choose/create text for Quick Setup Menu M00P19 and 
M00P20. 
 
To access the customizing wizard, open Customize 
Quick Setup Menu wizard from the Edit Drive 
Parameters menu. 
 
To begin, either: (1) Input your drive’s Serial Address 
(M11P23) in the “Drive Address” box on the Upload 
Parameter Data window, and click “Upload Menu 
Data” for online customization, or: (2) input your 
drive’s Software Version (M11P27) in the “Drive 
Software Version” box and click “Customize Offline”.  
After loading is complete, click “Next >>”. 
 

 
Figure 10. The Select Menu Parameters Window. 

 

In the Select Menu Parameters window, the Quick 
Setup Parameter are on the left, and parameters to be 
selected for the Quick Setup Parameter and are on the 
right. 
 

Select a Quick Setup Parameter on the left and change 
the binding parameter by clicking on a parameter on 
the right.   
 

After finishing the choices, click “Next  >>”.  You can 
also go back to the previous window by clicking “<< 
Back”. 
 

 
Figure 11. The Extra Options Window. 

 

Some Quick Setup Menu parameters (M00P19, 
M00P20) have extra options associated with them.  
You can set a scale parameter to convert the 
parameter values to some useful unit (for example, 
converting motor shaft RPM to pump flow rate).  You 
may also select a different name for the parameter 
from the list, or type your own custom name (e.g. 
“Flow Rate”).  To edit these extra options, choose the 
parameter to edit in the “Edit Options for Parameter” 
box  on  the  Extra  Options  window.   When  you  are 
finished, click “Next>>”.
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Figure 12. The Preview Window. 

 
The Preview window displays a preview of what your 
Quick Setup Menu will look like on the actual drive 
keypad.  If you are still connected to the drive, you 
may check “Show actual drive values in Preview” to 
read the actual values and use them in this preview.   
 
Click “Send to Drive” to send this Quick Setup Menu 
configuration to the drive.  If you have multiple drives 
you wish to have the same Quick Setup Menu, you 
may click “Save to File” to create a drive parameter 
data file (.USB file).  This drive parameter data file 
(.USB file) can now be downloaded to any compatible 
drive.  You can also click “<< Back” to change you 
settings or “Finish” to exit. 
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11.0  Online Graph/Log Window 
 

 
Figure 13.  Graph/Log Setup Tab in Online Graph/Log 

Window. 
 
The window allows the user to keep track of the status 
of a drive in real-time, log the data received, and also 
change the parameters on the fly. The Online 
Graph/Log window is accessed from the 
Scan/Graph/Log menu. At the top of the window, 
input the drive address you wish to query in the “Drive 
Address” box. This should match the drive’s “Serial 
Address” parameter (M11P23). Next, click the 
“Connect” button to connect to the drive. The 
progress bar will display the status of the connection, 
as Drivemaster connects to the drive and uploads the 
complete parameter list. The colored box in the upper 
right will flash to indicate communication with the 
drive. 

 
When the connection and upload is complete, the tree 
view on the left side of the window will be filled with 
the menus and parameters available on the drive.  
Skim through these parameters and check the boxes 
next to the parameters you wish to monitor (click 
“Remove All” to uncheck all currently checked 
parameters).  Input your desired scan period in hours, 
minutes, seconds, into the “Scan Period” box or check 
“Continuous Scan” box.   
 
Next, input a name for the file (the default is simply 
“scan.log”) in the “Log Filename” box, or click the 
“Browse….” button next to it.  
 
The log file is human-readable ASCII, but is also tab-
separated so that it can also be imported in a tabular 
format into most popular software (e.g. Microsoft 
Excel) for automated data processing. 
 
On the right side of the window the selected 
parameter will appear with parameter values in the 
value field.  You, the user can now choose an action 
for each parameter.  By clicking on the parameter 

action field, a list of actions for that parameter will 
display the user has a choice for Graph & Log, Graph 
only, Log only, and View or Edit only.  Each parameter 
has a color and gain field for graphing purposes.  By 
clicking on the color box, a color selecting standard 
window is displayed and change to a different color 
can be made.  This color field allows you to have a 
color choice for each parameter value to be graphically 
displayed.  By clicking on the parameter gain field, a 
window with gain values to choose will display.  This 
field allows you to adjust the graphical display of the 
parameter values. 
 
Click “Start Scan” to start scanning.  To end scanning, 
click the same button again (It will change to read 
“Stop Scan” when scanning is active). 
 
At intervals determined by the scan period you 
inputted, Drivemaster will poll the drive and read in 
the new values of the parameters in the value field.  
At the end of the scan period, depending on the action 
field for each parameter, the value will display on the 
“Graph Display” tab and/or written to the log file.  At 
anytime, you may click on a value and edit it live; your 
change will be sent to and verified from the drive 
immediately, and the new value will be displayed.  
Grayed-out parameters are read-only and cannot be 
edited.  Parameters with names for their values will 
allow the user to select from among the named 
values. 
 

 
Figure 14.  Graph Display Tab in Online Graph/Log Window. 
 
Finally, clicking on the graph display tab displays a 
graph of the histories of parameters that are selected 
for graphing on the previous tab.  The horizontal axis 
shows the most recent scan sweeps, or simply the 
most recent ones if the window is short.  The vertical 
axis of the graph plots the parameter values over 
time, and is scaled so as to fit the minimum and 
maximum values of all graphs displayed. 
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Clicking “Print Snapshot…” allows the user to print a 
hard-copy of the currently visible graph.  “Save 
Snapshot…” allows the user to save an image file of 
the same information.  Clicking the “Advanced 
Options” button opens the Configure Graph options 
dialog box as described below. 
 

 
Figure 15.  Graph Options Tab in Advance Options 

Configuration Window. 
 
The Graph Configuration display allows you to adjust 
some of the display settings for your graph display.  
On the left side you have two tabs, “Graph Options” 
and “Display/Decorations”, along with the graph 
example in the right side.  On the Graph Options tab, 
you may enter a title in the “Graph Title” text box 
which is displayed as the header for the graph.  You 
can choose the “Type of Graph” to display (“Line 
Graph”, “Hi/Lo/Current Graph”, or “Bar Graph”). 
 
Optionally, you may add a legend in one of four 
different locations on the graph, associating each color 
with its parameter.  The parameter number or 
parameter name (choose Short or Long) and graph 
display gain will appear in the legend (e.g. “M00P15”, 
“DC Bus Voltage”), alongside a sample arrow line, data 
point and arrow for reference.  You can include with 
the graph display the average values or current values 
of the parameter displayed. 
 
Finally, you may adjust how much data is displayed on 
the graph at one time, by inputting a maximum length 
of time into the box marked “Time to Display”.  For 
example, if you enter “00:05:00” into this box, the 
graph will only display results less than five minutes 
old, even if more data exists.  (This time is relative to 
the most recently collected data point, so if you pause 
scanning, the graph will pause as well.) 

 

 
Figure 16.  Display/Decorations Tab in Advance Options 

Configuration Window. 
 
Using the Display/Decorations tab, you can change the 
fonts for the Title and Data, as well as the graph 
colors for the Background, Axes, Rules and Data/Text.  
By clicking on the “Change” button for Fonts, a font 
selecting standard window is displayed and a change 
to a different font can be made.  By clicking on the 
color box for Graph Colors, a color selecting standard 
window is displayed and a change to a different color 
can be made. 
 
The X-Axis and Y-Axis can be displayed on the Graph 
by selecting the appropriate box.  The X-Axis labels, 
which is either the parameter number or parameter 
name (choosing Short or Long) can also be displayed.  
The X-Axis labels are only displayed in Hi/Lo/Current 
Graph or Bar Graph display. 
 
When you are done with your choices, click “Apply” 
button to see changes immediately, click “OK” button 
for changes to take effect and exit the window, or 
click “Cancel” to exit the window without changes. 
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12.0  Upgrade Drives Firmware Wizard 
 

 
Figure 17.  The Select Drive Window. 

 
To upgrade drives Firmware, select “Apply Firmware 
Upgrade” from the main windows Communications 
Setup menu.  This will open a Upgrade Drive Firmware 
wizard.  This wizard will upgrade your drives firmware 
using a firmware update file (.FUP file) available from 
US Drives. 
 
First, enter your drive’s “Serial Address” parameter 
(M11P23) in “Drive Address” box, in the Select Drive 
window.  You can choose a Serial Port or Ethernet 
communication connection.  The communication 
connections you have choosen can also be configured 
by clicking  Configure Serial Port or Configure 
Ethernet.  Configuring the communications is 
explained in section 4.0 Configuring the 
Communications.  After everything is configured, you 
may click “Test Communication” to verify that the 
drive is connected and accessible.  After 
communication connection is successful, click 
“Next>>”. 
 

 
Figure 18.  The Load Upgrade File Window. 

 
In the Load Upgrade File window click “Browse” to find 
the Firmware Upgrade File (.FUP file) you wish to 
apply to your drive.  The latest Firmware Upgrade files 
are available from US Drives.  Depending on your 
application, you may be provided with a customized 

firmware upgrade file.  After selecting your firmware, 
upgrade file, click “Next>>”.  You can also go back to 
the previous window by clicking on “<< Prev”.  
 

 
Figure 19.  The Perform Upgrade Window. 

 
Drivemaster is ready to upgrade your drives firmware.  
Click “Next>>” to begin the upload.  This upgrade will 
take several minutes, depending on your 
communications settings.  DO NOT turn off or 
disconnect the drive during the upgrade, doing so may 
leave your drive in an unrecoverable state, requiring 
factory maintenance repair. 
 

 
Figure 20.  The Upgrade Complete Window. 

 
Your firmware has been successfully upgraded.  Click 
“Finish” to exit Upgrade Drive Firmware Wizard. 
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13.0  How to View Drivemaster Version 
 
By Selecting “About Drivemaster…” from the Help 
Menu in Drivemaster will display the current 
Drivemaster Version. 
 

 
Figure 21.  The About Box, Showing the 

Version Support Information. 
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COMMON OPTIONS AND INTERCONNECTS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WARNING: To avoid a hazard of electric shock, after the input and control power is removed from the 
drive and the ROM display is no longer lit, wait five (5) minutes for DC bus capacitors to fully discharge 
before opening the drive. Verify that the voltage on the DC bus capacitors has discharged by measuring 
the DC bus voltage at the +DC & -DC terminals of the drive. The voltage must be zero. 
 
CAUTION: This drive contains ESD (Electrostatic Discharge) sensitive parts and assemblies. Static 
control precautions are required when installing, testing, servicing or repairing this assembly. Component 
damage may result if ESD control procedures are not followed. 
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Isolated Communications Card 3000-4135-1 (1 of 2) 
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Isolated Communications Card 3000-4135-1 (2 of 2) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mounting Diagram 
For Control Board 3000-4100 & 3000-4130 
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Isolated Communications Card 3000-4135-1 (2 of 2) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mounting Diagram 
For Control Board 3000-4101 & 3000-4131 
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Removable USB/RS-485 Isolated Communications Interface with Cable 

P/N: 3000-4226-USB 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mounting Diagram 
For Control Board 3000-4100 & 3000-4130 
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Removable USB/RS-485 Isolated Communications Interface with Cable 

P/N: 3000-4226-USB 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mounting Diagram 
For Control Board 3000-4101 & 3000-4131 



 

Data Subject to Change Without Notice 
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